
What’s New in Brio Intelligence 6.6

This document describes enhancements in the Brio Intelligence 6.6 release. 
The defect corrections are listed in the Readme file distributed with the 
product or available from Brio Customer Support.

This document contains:

■ OLAP Query Section Enhancements

■ Data Model and Connectivity Enhancements

■ Brio Intelligence Server Enhancements

■ Improved EIS Development Environment

■ Object Model Enhancements

■ General Enhancements
What’s New in Brio Intelligence 6.6 1



OLAP Query Section Enhancements
Brio Intelligence 6.6 OLAP Query Section contains the following enhancements:

■ Drill-Through To Relational Source Data

■ Automatic Creation Of OLAP Query Results

■ New OLAP Query Options Menu Item

■ Ability To Hide Member Labels

■ New OLAP Query Drill-Down Options

■ Improved Performance Against SAP BW

Drill-Through To Relational Source Data
Brio Intelligence 6.6 adds the ability to link an OLAP Query to its relational 
source data. This ability is accessed through the new Set Drill-Through menu 
item of the OLAP menu. The dialog displayed by this menu item (see below) 
allows a Brio Intelligence user to map a Dimension of an OLAP cube to a table 
of a relational database (with the assumption that the OLAP cube is 
represented by a simple Star Schema model in the relational database). 

If such a mapping has been done, when users try to drill past the lowest level of 
the OLAP cube, users are asked if they wish to drill through to the relational 
source data (thus allowing a lower level of data granularity to be exposed). If a 
user agrees , the OLAP and relational source data will be presented in a new 
Pivot Section display.
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Automatic Creation Of OLAP Query Results
To enhance the similarity between the OLAP Query and relational Query 
Sections, Brio Intelligence 6.6 allows the user to automatically create a local 
Results Section when an OLAP Query is first Processed. This option (default is 
disabled) is enabled via a new property in the Tools →Options → Program 
Options menu item (under a new OLAP tab).

New OLAP Query Options Menu Item
Many of the OLAP properties that were previously available as distinct menu 
items under the OLAP menu are now found grouped together within a new 
OLAP Query Options menu item found under the OLAP menu. This new 
grouping is a more logical place for many of the OLAP specific properties. 
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Selecting the new menu item will present the user with a new dialog (see 
below) from which the various OLAP properties can be set. The dialog further 
groups properties under the following two tabs:

■ General OLAP tab – Properties pertaining to all OLAP analyses

■ Database Specific tab – Properties available only for the particular database 
being queried 

Properties previously under the OLAP menu, but now on the OLAP Query 
Options menu General tab are: Database Totals, Hardwire Mode, Slicer Display 
and the new Drill Down Options (see “New OLAP Query Drill-Down 
Options” on page 7). 

For connections to Essbase databases, the properties under the DB Specific tab 
are: Suppress missing rows, Suppress zero rows, Alias table selection. 
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For OLE DB for OLAP compliant databases, the DB Specific tab contains the 
Suppress empty rows property.

Support For Essbase Attribute Dimensions
Hyperion Essbase Attribute Dimensions are now fully supported in Brio 
Intelligence 6.6. Attribute Dimensions are displayed in the Catalog Pane OLAP 
Tree following the regular Dimension names (see below). The Attribute 
Dimensions have the text (Attribute) following their name. Attribute 
Dimension Levels can be used in combination with any Base Dimension to 
enhance the meaning of Essbase data. Additionally, Attribute Calculations are 
also visible as a separate dimension and the calculation functions can be used 
in combination with any Attribute Dimension Level or Member.
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Ability To Hide Member Labels 
The OLAP Query Section now has the ability to hide any Top or Side Member 
Label in the Contents Pane display. This functionality exactly emulates the 
functionality found in the Brio Intelligence Pivot Section. 

The ability to hide Member Labels allows the user to clarify the Contents Pane 
display by temporarily removing unwanted Member information. If a Member 
is hidden, any child or descendent Member information is also hidden. 
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The Hide command is available from the right-click speed menu after clicking 
on any Member Label(s) in the Contents Pane. Previously hidden items can be 
re-displayed by selecting Show Hidden Items, also from the right-click speed 
menu.

New OLAP Query Drill-Down Options
BI 6.6 makes available new drill down options that can speed up and clarify the 
display of information for dimensions that have large amounts of Level data.

Previously in Brio Intelligence, a user could only drill down on a Member to 
reveal data at the next Level of a dimension. For example, if a dimension 
contained Levels of: Country, State and City, a user would have to drill down 
on the “USA” Member to reveal all States in the USA and then subsequently 
drill down on the “California” Member to reveal all Cities in California.

In Brio Intelligence 6.6, the user has two new options for drill down: 

■ Drill To All Levels shows all information about Member descendants in one 
drill down operation. That is, in the above example, Drilling Down on USA 
would show data for all States and all Cities in the USA at once.

■ Drill To Lowest Level shows only the data for Members at the lowest Level 
(while retaining the parent) in one drill down operation. That is, in the 
above example, Drilling Down on USA would show data for all Cities in the 
USA at once.

Additionally, the previously available Drill To Next Level option is also available 
and is the default drill-down option. With this option, Drilling Down on “USA 
would reveal only all States in the USA as described above.

The new drill-down options are found in the new OLAP Query Options menu 
item under the OLAP menu (see image in “New OLAP Query Options Menu 
Item” on page 3).

Improved Performance Against SAP BW
The OLAP Query Section has been updated to improve Query performance 
when accessing SAP BW databases. The improvements have been made by 
using more efficient MDX statements to reduce the number of accesses to the 
BW server and also by better caching of data at the Brio Intelligence client.
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Data Model and Connectivity Enhancements
The data model and connectivity enhancements include:

■ Upgraded Oracle Connectivity

■ Oracle Stored Procedures

■ Persistent Data Model Options

Upgraded Oracle Connectivity
Brio Intelligence 6.6 is upgraded to use the functions offered in the call 
interface to Oracle version 8. The version 7 functions do not allow access to the 
newer Oracle features planned for future releases of Brio Intelligence and are 
being dropped from support by Oracle. While it is still possible to connect to 
Oracle version 7 databases, when Brio Intelligence components require a 
connection to an Oracle database, these components require that Oracle 
version 8 clients be installed.

Oracle Stored Procedures
Starting with Brio Intelligence 6.6, Oracle stored procedures can be used to 
return result sets. This requires an ODBC connection to the Oracle database 
and the procedure must use Reference Cursors as a procedure parameter. This 
parameter type allows the ODBC driver to convert the returned data from the 
procedure into the standard ODBC method of reading results. Because these 
appear as a parameter to the procedure, version 6.6 recognizes this parameter 
type and will handle it appropriately when calling the procedure. 

Persistent Data Model Options
Prior to version 6.6, each data model was created with a default set of options. 
The user could not change these defaults, and so for each new data model, the 
user might have had to make changes to the defaults to meet their particular 
requirements. For example, the user might require the join method use all 
joined topics for each data model created, but the default applied was automatic 
join path generation. 
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Starting with Brio Intelligence 6.6, the user can specify persistent data model 
options. These options will be used each time a new data model is created. 
Subsequent changes to the options for a specific data model do not affect the 
user’s preferred settings, and existing data models are not affected by changes 
to the preferences. 

The Save as Default button stores the user’s data model preferences. To make 
changes to the stored data model preferences without affecting the current data 
model, click Save as Default followed by Cancel. To make changes to the 
current data model without affecting the saved preferences, click OK only. To 
change the preferences and make them applicable to the current data model, 
click Save as Default followed by OK. 

Certain data model options are specific to a given data model. These options 
are not preserved. In particular, topic priority and the enabled state of audit 
events are not preserved. The audit SQL statements are retained, however, and 
can be enabled at a later time. Consult the product documentation for 
additional information.
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Brio Intelligence Server Enhancements
The Brio Intelligence servers include the following enhancements:

■ “Run Next Poll” Scheduling Option

■ Row Level Security

“Run Next Poll” Scheduling Option
Broadcast Server administrators, using the version 6.6 Server Administration 
program, can trigger any job to run the next time the server polls the 
repository connection. Previously, it was only possible to do this for ASAP 
jobs. With this new feature, jobs that might have failed due to a database issue 
or other problem without altering the scheduling parameters can now be rerun 
on demand. 

For example, an end-of-month job might have run at its scheduled time, but 
not all the end-of-month data had been input by that deadline. Using this 
feature, the server administrator can rerun the job once the data entry has been 
completed without having to change the scheduling parameters to ASAP and 
then back to the monthly interval.

To use this feature, access the Job List in the Server Administrator, select the 
job that needs to be run, and click the Run Next Poll button. Between this 
action and the time of the poll, the Completion Status of the job will indicate 
the request to run the job at the earliest opportunity.
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Row Level Security
For the OnDemand and Broadcast Servers, Brio Intelligence version 6.6 
introduces the ability to restrict the relational data a user can select based on 
the user’s name and their membership in groups. For example, Sales data can 
be restricted such that a particular user can only see the data for the particular 
Sales Region to which that user reports. 

Restrictions can be applied at both the row level and the column level. The 
Sales example above is an example of Row Level Security. To give access to all 
users to Human Resources data, except for the Salary field, specify that the 
Salary field is to always be restricted, regardless of whom the user is. In this 
case, the user will see NULL values for the Salary data.

Methods are provided for users who have special access requirements (for 
example, there will be people who need access to the Salary field) to get that 
access. These specifications are known as “override” conditions. If required, 
new restrictions can be added to the same field. For example, while all users are 
restricted from accessing Salary information, an override can be given to 
members of the MANAGER group, allowing access, but specifying that such 
access is only available to the Salary field of their own direct reports.

Regardless of the data model used, the specifications allow for the inclusion of 
required join tables not already present in the model, and the power of SQL 
can be used to produce sophisticated restrictive logic. To get a full 
understanding on the usage and implementation of the Row Level Security 
feature, contact the Brio Software Systems Consulting organization for the 
white paper, An Introduction to Row Level Security. 

Improved EIS Development Environment
The following areas were improved in the EIS development environment: 

■ Toolbar

■ Object Navigation

■ Search and Replace

■ Resizable Text Editor
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Toolbar
For easy access to commonly accessed functions, a new toolbar has been added 
to the EIS Development Environment. The toolbar provides the cut, copy, 
paste, and search/replace functions.

Object Navigation
It is now possible to navigate between all objects on a single EIS page from 
within the EIS Development Environment. Instead of having to open and close 
the Development Environment for every object, the user is able to open the 
Development Environment once per EIS page and effectively have access to all 
objects on that page and their associated events. 

Search and Replace
Search and Replace capabilities are now available for the Text Editor in the EIS 
Development Environment. Users can search from top to bottom or from 
bottom to top, matching whole words or by case, and by replacing one or all 
occurrences of a matching string.
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Resizable Text Editor
The Text Editor pane in the EIS Development Environment is resizable in 
height and width in proportion to the Object Browser pane. Using the lower 
right corner resize control of the Object Browser pane, users can resize the Text 
Editor and Object Browser areas.
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Object Model Enhancements
Object model enhancements include:

■ Exposed Data Model and Query Section Limit Line Parentheses in Object 
Model

■ Exposed Report Section in Object Model

Exposed Data Model and Query Section Limit Line 
Parentheses in Object Model
In both the Data Model and Query sections of a BQY document, users can 
create and manipulate expressions on the limit line. A limit line expression can 
include limit line values (column names/topic items), logical AND/OR 
operators, and parentheses for defining precedence or separating values. 

The object model already provides users with access to limit line values and the 
logical AND/OR operators. With this release, Brio Intelligence 6.6 exposes the 
limit line parentheses in the object model for both the Data Model and Query 
sections. Users can set and get values for limit line parentheses.
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Given the following limit line expression: ‘Region AND Quarter AND Year’, 
applying the following methods will result in: ‘(Region AND ((Quarter) AND 
Year))’:

ActiveDocument.Sections["Query"].Limits.Parentheses.Add(‘Quarter’,’Year’);
ActiveDocument.Sections["Query"].Limits.Parentheses.Add(‘Region’,’Year’);
ActiveDocument.Sections["Query"].Limits.Parentheses.Add(‘Quarter’);

Based on the same limit line expression from above, the following properties 
can be read:

//Returns ‘Quarter’
FirstBegLimitName = 
ActiveDocument.Sections["Query"].Limits.Parentheses[1].BegLimtName;
//Returns ‘Year’
FirstEndLimitName = 
ActiveDocument.Sections["Query"].Limits.Parentheses[1].EndLimtName;
//Returns ‘Quarter’
SecondLimitName= = 
ActiveDocument.Sections["Query"].Limits.Parentheses[2].BegLimtName;
Or
SecondLimitName= = 
ActiveDocument.Sections["Query"].Limits.Parentheses[2].EndLimtName;
//Returns 3; 
ParenthesesPairCount = ActiveDocument.Sections["Query"].Limits.Parentheses.Count;
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Exposed Report Section in Object Model
With Brio Intelligence 6.6, the Report section of a BQY document is exposed in 
the object model. Users can programmatically manipulate section attributes, 
headers, footers, groups, and body areas of a Report section. Users have access 
to graphics objects, field objects, embedded objects, and table objects. Also 
available are functions such as sorting, expressions, page break, keep with next, 
keep together, spring/unspring, color, font, and line width. Much more is 
available that is not mentioned in this document.

General Enhancements
Brio.Enterprise 6.6 includes the following general enhancements:

■ Support for Section Export to PDF Format

■ Export to Lotus 1-2-3 in Report Section

■ Optional CSS File on HTML Export

■ Support for Report Table Break Totals

■ Addition of Table Column Background Properties

■ Display of Logarithmic Scale in Chart Section
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Support for Section Export to PDF Format 
Brio Intelligence 6.6 introduces support for PDF export of all printable 
sections except for the Query and Data Model sections. PDF export is available 
from Brio Intelligence client, web-based clients, and the Broadcast Server. 

For each supported section, the new export PDF functionality is available from 
the UI through the File→Export→Section dialog.    A new option of  “Acrobat 
(*.pdf)” is available from the Save as type field in the Export Section dialog.

PDF Export is also available from the Object Model. Section Export already 
exists as an object model method. An additional constant, 
bqExportFormatPDF, has been added to the BqExportFileFormat constant 
group to support PDF Export.

//Export Report section to PDF format

Documents["MyBasic.BQY"].Sections["Report"].Export("C:\\Temp\\M
yReport",bqExportFormatPDF,0,0)

Export to Lotus 1-2-3 in Report Section
It is now possible to export the content of a Report Section in WKS format. 
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Optional CSS File on HTML Export
The Cascading Style Sheet (CSS) file is used to apply a common “look and feel” 
to a set of related HTML pages. Brio Intelligence creates this file by default 
when exporting most sections to HTML format, giving each a “high fidelity” 
rendition in HTML of the section as seem in the Brio client itself.

Because it is an extra file, it is sometimes less convenient, such as when 
emailing an HTML page for example. Brio Intelligence 6.6 makes it possible to 
have the style information embedded in the HTML file itself.   

To embed the style information in the HTML file, access the Export properties 
dialog off the Format menu and uncheck the box labeled Export with Style 
Sheet (CSS). This box is checked by default. To further fully take advantage of 
this feature, it may also be useful to set the option to export without page 
breaks. (In a Report section, set the page dimensions to a custom size to 
eliminate page breaks.)

Support for Report Table Break Totals
Brio Intelligence 6.6 introduces support for break totals in Report Tables. This 
feature is similar to what is available in the Results/Table sections, providing 
users the ability to easily create break totals on a selected column by a 
particular data function.
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The default data function for Break Totals is SUM. Note that the data function 
option applies to the entire report table (facts, grand total). Therefore on 
creating a Break Total, it is possible that the user might reset the data function 
for the entire report table. Also note that any existing sorts in a report table are 
overwritten when a Break Total is applied.
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Addition of Table Column Background Properties
Prior to this release, it was possible to set the background properties for an 
entire table. With Brio Intelligence 6.6, it is now also possible to apply the 
background properties for individual columns of a table as well.   The 
alternating row color functionality is preserved for both individual columns 
and the entire table. Users can now alternate row colors at the column level or 
table level.

Do note that the last applied color is the current color. Take caution when 
applying entire table border and background properties after setting individual 
column colors—the individual column color schemes will be overwritten by 
the entire table settings.

Along with this functionality, the Borders and Background option has been 
added to the Right Mouse PopUp Menu for easier access.
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The Borders and Background feature for table and column is now also 
available in the Brio Object Model. 

//Set the border color and width for the entire table
ActiveDocument.Sections["Results"].Border.Color=bqBlue
ActiveDocument.Sections["Results"].Border.Width=2

//Set the background color and alternating row colors for an entire table
ActiveDocument.Sections["Results"].Background.Color=bqBlue
ActiveDocument.Sections["Results"].Background.AlternateColor=bqRed
ActiveDocument.Sections["Results"].Background.AlternateFrequency=2
ActiveDocument.Sections["Results"].Background.ShowAlternateColor=true

//Set the background color and alternating row colors for an individual column
ActiveDocument.Sections["Results"].Columns["Unit 
Sales"].Background.Color=bqYellow
ActiveDocument.Sections["Results"].Columns["Unit 
Sales"].Background.AlternateColor=bqPink
ActiveDocument.Sections["Results"].Columns["Unit 
Sales"].Background.AlternateFrequency=1
ActiveDocument.Sections["Results"].Columns["Unit 
Sales"].Background.ShowAlternateColor=true
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Display of Logarithmic Scale in Chart Section
The Chart Section will now allow the display of a logarithmic scale when data 
values less than one are present. In prior versions of Brio Intelligence, an error 
message would be displayed when values less than one were present and the 
Chart would revert back to non-logarithmic scaling.

In Brio intelligence 6.6, if a logarithmic scale is selected and values less than 
one are present, these values will be represented as zero on the logarithmic 
scale (and a suitable informational message will be displayed on the Status 
Bar).
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